Table of Contents

Accessibility Options (Win 95) ................................................................. 1
CloseView (Mac) .................................................................................. 5
Dragon NaturallySpeaking (1.0) (Win) ............................................... 7
Easy Access (Mac) ........................................................................... 13
JAWS 3.0 for Windows 95 ................................................................. 15
outSPOKEN (Mac) ........................................................................... 29
pwWebSpeak (Win) ........................................................................... 31
ZoomText Xtra (Win) ................................................................. 35
Accessibility Options (Win 95)

Publisher: Microsoft Corp.
One Microsoft Way
Redmond, WA 98052-6399
(206) 635-7245
www.microsoft.com/enable

Retail Cost: Included in OS

System Requirements:
The Accessibility Options are found in the Windows 95 Control Panel which is accessed through Settings on the Start menu. The Accessibility Options are included in the default Windows 95 installation.

Description:
The Accessibility Options include five types of adaptive system support: Keyboard, Sound, Display, Mouse, and General.

Recommended Uses:
The Options provide system support for: persons with physical difficulty in using the keyboard; persons who have visual disabilities and need larger print, stronger contrasts or larger mouse pointer; persons who are deaf or hard of hearing and need to see sound events; and, persons using a serial device to connect to the computer. What is singular about this cluster of operating system support is the fact that previously, almost all of these features had to be purchased from third party vendors.

Basic Use:
1. Enter Ctrl-Escape to bring up the Start menu.
2. Double Click on Accessibility Options. The Accessibility Properties window appears.
3. Click on a properties tab to go to a support feature.

The Keyboard Properties Tab
Three features: StickyKeys, FilterKeys, ToggleKeys are available; each has a settings window which is reached by clicking on a Settings button.

- StickyKeys
Use sticky keys to latch the special keys (Ctrl, Alt, Del) or the shift keys. When one of these keys is pressed, it latches and releases only when a second
key is pressed, e.g., Ctrl-P. Tapping shift or a special key twice latches it down (e.g., to type many asterisks); tapping it again will unlatch it if that option has been set. This feature is used when the keyboard user is unable to hold two keys down at the same time.

The keyboard shortcut to turn sticky keys on is to tap the Shift key 5 times. There are additional options which may be selected for the StickyKeys feature: turn off StickyKeys when two keys are depressed at the same time (automatically turning the feature off for a regular typist); make a sound when a special key is pressed, and a very important feature, the ability to show a visual display of whether a special key is latched or not. Having the visual display on the screen is useful information for persons with short term memory deficits. Right clicking on this reminder brings up an option to adjust settings.

**FilterKeys Properties Tab**
There are two types of options which may be set from the main FilterKeys property sheet. The one most frequently used the second radio button option. This controls the function of RepeatKeys and SlowKeys.

- **RepeatKeys**
  This option will override settings on the Keyboard control panel. It is possible to turn off keyboard repeat entirely, or is it possible to slow down the rate at which the key repeat function repeats. Students with slow visual processing speeds benefit from a slowed key repeat function because it is easier to track the cursor. Students who are unable to quickly lift their hands off a key will benefit from having the repeat delay increased (a finger can stay on a key a bit longer before a key repeat begins).

- **SlowKeys**
  The SlowKeys function allows the user to set a time delay before a keystroke is registered. This in effect can create a virtual keyguard for the student who strikes many keys while moving over the keyboard to the target keystroke. No keystroke will be registered until a key has been depressed for a minimum length of time.

The keyboard shortcut which turns FilterKeys on is to hold down the Right Shift key for eight seconds. This option will not work unless the Use shortcut box is selected.

- **ToggleKeys**
  Choosing this function invokes a tone when one of the special locking keys is pressed (Caps Lock, Scroll Lock, Num Lock).
The Sound Properties Tab
At the current time, only one of the two options works: SoundSentry. Using this option generates visual warnings when a system sound occurs. From its Settings window, it is possible to have alerts for windowed programs or full screen text programs.

For Windowed Programs
Flash active window or flash the desktop

For Full Screen Text Programs
Flash display, characters, or border

The ShowSounds feature will display captions for speech and sounds generated by an application which has been designed to work with this feature. Currently this feature is not widely supported.

The Display Properties Tab
From the front of this panel it is possible to invoke High Contrast color scheme if an application is "smart" about this feature. The Settings window allows the user to choose to invoke the shortcut key, Left Alt-Left Shift-PrintScreen and to set specialized high contrast color schemes.

It is possible to set everything to white on black or black on white, or specialized color sets. Many color sets come with standard, large and extra-large font choices.

The Mouse Properties Tab

Only one set of functions is controlled by this tab: the ability to use the numeric keypad to move the mouse pointer. It is possible to modify cursor speed as well as to use Ctrl to speed up mouse movement and Shift to slow down mouse movement.

The General Control Panel Tab

• Automatic Reset
From this level it is possible to set a time limit on keyboard inactivity; when that limit is reached, all accessibility functions automatically turn off.

• Notification
It also is possible to ask for warning messages when features turn on, or to set a sound to occur when a feature is turned on and off.
- **SerialKey Devices**
  For students needing to connect serial communication devices to a computer, this access panel allows the user to set which serial port to use and what baud rate to use.

**Notes:**
CloseView (Mac)

Publisher: Apple Computer Corp.
20525 Marian Avenue
Cupertino, CA 95014
(800) 800-2775

Retail Cost: $Free

System Requirements: Any Macintosh

Description: CloseView is a utility that comes included with every Macintosh. It is designed to make it easier for users with visual impairments to read or view screen images. Contents on the screen may be magnified two to sixteen times. Display of the screen can be inverted to make images appear white on black instead of black on white.

Recommended Uses: CloseView is typically used by students with low vision, a brain injury or a learning disability. By adjusting the size of text or changing the background/foreground the right combination can be achieved for nearly all needs.

Basic Use:

Installation:
1. Copy CloseView into the System folder by dragging the magnifying glass icon onto the System folder on the startup disk.
2. Restart the Macintosh.
   The installation process needs to be performed only once.

Use:
1. Press Option-Command-O keys to turn CloseView On/Off.
2. Press Option-Command-X keys to turn magnification On/Off.
3. To increase/decrease the power of magnification, hold down Option-Command then press up/down arrow keys.
4. Select the CloseView icon from the Control Panel to see other options.

Notes:
**Dragon NaturallySpeaking (1.0) (Win)**

**Publisher:**
Dragon Systems  
320 Nevada Street  
Newton, MA 02160  
(800) 825-5897  
www.dragonsys.com

**Retail Cost:** $350.00 approx.

**System Requirements:**
Microsoft Windows 95 or newer, or Windows NT, 133 MHz or faster, 32 mb. RAM for Windows 95, 48 mb. RAM for Windows NT.

All systems require a sound board, Currently, the following soundcards have been tested and certified for Dragon NaturallySpeaking:

- Sound Blaster 16 PnP (Creative Labs, Inc.)
- Sound Blaster AWE32TM PnP (Creative Labs, Inc.)
- Sound Blaster AWE64TM PnP (Creative Labs, Inc.)
- Sound Blaster AWE64TM Gold PnP (Creative Labs, Inc.)
- AudiotrixTM Pro (MediaTrix Peripherals, Inc.)
- EnsoniqTM SoundScapeTM VIVO 90 (must be purchased directly from Ensoniq, Corp.)
- EnsoniqTM Audio PCI (32-bit) (Ensoniq Corp.)
- ExpertMedia Med 3240 with OPTi chip set (Expert Media)
- Turtle BeachTM Tropez Plus (Turtle Beach Systems).

**Description:**

Dragon NaturallySpeaking is a speaker dependent, continuous speech recognition system. The active vocabulary size is 30,000 words with a 230,000 word dictionary which allows for accurate word prediction and spelling. Text can be dictated at around one-hundred words per minute. At the present time, the system accommodates only one voice profile per computer.

**Recommended Uses:**

This program is recommended for persons with repetitive strain injury or moderate to severe physical disabilities.

**Basic Use:**
Dragon NaturallySpeaking must be individually trained by each user. Training is accomplished through use of the General Training program. Creating a voice profile and completing the training process takes about 45 minutes. Unlike previous versions of Dragon Dictate which were always used in combination with other programs, often, word processors, NaturallySpeaking works within its own dedicated word processing environment and is intended for text dictation rather than applications control. When using NaturallySpeaking, the following steps are taken:

1. Load NaturallySpeaking from the Programs menu.

2. Activate the microphone by pressing the numeric keypad + key.

3. Begin speaking clearly and distinctly in short phrases with brief pauses between each phrase.

4. If a phrase or word selected by NaturallySpeaking is incorrect say "Correct" and the word or phrase to be corrected.

5. If the correct phrase or word appears in the suggestion list, say "Choose" and then the number of the desired phrase or word in the selection box.

6. If the desired phrase or word does not appear in the selection box, say "Spell That" and begin spelling the word using the letters of the alphabet. Generally, the correct phrase or word will be identified after the first one or two letters have been spoken. When the desired phrase or word appears, say "Choose" and the number of the phrase or word.

**Intermediate Use:**

Users can insert punctuation marks by saying the name of the mark, (i.e. "period", "comma", "question mark"). A variety of options exist for selecting text. Saying "Select" then word, line, paragraph or document selects a portion of text which can then be edited or formatted in a number of ways. (See attached Quick Reference Guide)

**Notes:**

Speaking distinctly and in short phrases will dramatically improve recognition performance. Saying "Thank you for your letter" brief pause "inviting me to the opera" brief pause "next Saturday night." will work better than saying the whole sentence.
NaturallySpeaking

At a glance, here are all the voice commands grouped according to when you can say them.

**Global Commands**

Microphone Off
Go to Sleep/Wake Up
Click (Menu or Button Name)
Move Left/Right/Up/Down 1-20
Move Left/Back/Right/Forward 1.20 Characters
Move Up/Down/Back/Forward 1-20 Lines
Select Next/Forward/Previous/Back Character
Select Next/Forward/Previous/Back Lines
Delete Next/Forward/Previous/Back Character
Delete Next/Forward/Previous/Back 1-20 Characters
Undo Last Action
Undo That
Copy All to Clipboard
Paste That
Switch to Next/Previous Window
Switch to Next/Previous Window
Switch to NaturallySpeaking
What Can I Say
Give Me Help
Give Me Help on (Topic)

**Editing Commands**

Go to Top/Bottom
Move Left/BacklRightlForward/a word
Move Left/Back/Right/Forward 1-20 words
Move Left/Back/Right/Forward/ a paragraph
Move Left/Back/Right/Forward/ 1-20 paragraphs
Move to/Go to
   Top/Start/Beginning/End of line/Paragraph
   Document/Selection
Select Word/Line/Paragraph/Document
Select Next/Forward/Previous/Back Word
Select Next/Forward/Previous/Back 1-20 words
Select Next/Forward/Previous/Back Paragraph
Select Next/Forward/Previous/Back 1-20 Paragraphs  
Set Font (Face/Size/Style)  
    face = Arial, Courier, Courier New, Times,  
    Times New Roman  
    size = 4-120  
    style = Bold, Italic, Plain, Plain Text,  
            Regular, Underline  

**Dictation Commands**  
New Line/Paragraph  
Tab Key  
All Caps  
All Caps On/Off  
Caps  
Caps On/Off  
No Caps  
No Caps On/Off  
No Space  
No Space On/Off  

**Correction Commands**  
Scratch That  
Correct That  
Correct text  
Select text  
Select Again  
Spell that abc  
All Caps That/Selection  
Cap That/Selection  
No Caps That/Selection  

**Correction Dialog Box Commands**  
Choose 1-10  
Select 1-10  
Select Line  
Select Next/Forward/Previous/Back Word/Character  
Select Next/Forward/Previous/Back 1-20 Words/Characters  
Move Left/Back/Right/Forward a Word/Character  
Move Left/Back/Right/Forward 1-20 Words/Characters  
Move to Top/Start/Beginning/Bottom/End of Line
Go to Top/Bottom
Go to Top/Start/Beginning/Bottom/End of Line
Cut That/Selection
Delete That/Selection
Delete Next/Forward/Previous/Back 1-20 Words/Characters
abc = Letters a-z, numbers 0-9 apostrophe, dash, hyphen, space, bar, Cap, question mark, slash
other punctuation marks (say with a brief pause)
Easy Access (Mac)

Publisher: Apple Computer, Inc. (Headquarters)
1 Infinite Loop
Cupertino, CA 95014
(408) 996-1010
(800) 800-2775
www.apple.com

Retail Cost: $Free

System Requirements:
Macintosh

Description:
Easy Access is a control panel in the system folder. This control panel provides three features, "Sticky Keys," "Mouse Keys," and "Slow Keys." These features assist people with disabilities who have difficulty typing with both hands on the keyboard, or manipulating the mouse. The "Sticky Keys" feature lets the user type combination keystrokes without pressing the keys simultaneously. The "Mouse Keys" feature allows for manipulation of the pointer using the numeric keypad instead of the mouse. The user can click, drag, and perform all the usual mouse activities. The "Slow Keys" allows the user to set an interval for a delay before a keystroke is accepted.

Recommended Uses:
Good for anyone using one-hand for keyboard input or having limited control or range of motion.

Basic Use:
To use any Easy Access feature, open the Easy Access control panel, and make appropriate selections. If desired, the user can invoke the features in the following ways, without opening the control panel:

Sticky Keys:
1. Press the shift key five times to turn on sticky keys. Notice the appearance of a small icon in the right end of the menu bar. A small arrow appears over this icon when you press any of these four modifier keys: Control, Shift, Option, and Command indicating this key is set.
2. Press the modifier key again and that key is locked for multiple keystrokes.
3. Press the modifier again to unlock it.
4. Tap **Shift** five times to turn off the sticky keys feature.

**Mouse Keys:**

1. Press **Command-Shift-Clear** to turn on mouse keys. Remember it is possible to use the sticky keys feature to do this.
2. Use the numeric keypad to move the pointer, click, drag and so on. The number keys around the 5 key move the pointer. The **5 key** operates as the mouse button: press once to click, press twice to double click. The 0 key locks down the mouse button (for dragging). The **decimal-point key** unlocks the mouse button.
3. Press **Command-Shift-Clear** to turn off the mouse keys feature.

**Slow Keys:**

1. To turn on Slow Keys, press the **Return** key for about 8 seconds, at the Finder level only. (After 4 seconds, you will hear a short warning beep.)
2. Press the keys as you normally do.
3. To turn off Slow Keys, press the **Return** key for about 8 seconds, at the Finder level only. (After 4 seconds, you will hear a short warning beep.)

**Notes:**
JAWS 3.0 for Windows 95

Publisher
Henter-Joyce, Inc.
11800 31st Court North
St. Petersburg, FL 33716-1805
(800) 336-5658
www.hj.com

Retail Cost: $ 795.00
($ 95.00 upgrade from 3.1)
($100.00 for a one-year Software Maintenance Agreement)

System Requirements
A machine running the Windows 95 operating system

Description
JAWS for Windows is a screen reader which uses the numeric keypad for its basic functions. A number of interactive hot key commands are available to change settings easily.

There are two particularly strong features in JAWS which help the user: Verbosity Level and Help.

1. There are three levels of verbal assistance provided to the user: a lot (novice), some and little (advanced). The default full verbosity level is very informative for the user.

2. The help function in JAWS for Windows is very well developed. The online help for JAWS is extensive, and there is included an additional level of help: context-sensitive help.

Extensive information about the Windows environment is included with the JAWS documentation. A developed macro language also comes with JAWS so that customization may be done by advanced users.

Basic Commands

Working with Context Sensitive Help
JAWS has a powerful on-demand Help feature that provides verbal information and/or instructions for a current task. At any time:

- use Insert FL to hear screen sensitive help--useful for learning windows.
- use Insert H to hear JFW macro hotkey commands and some context-sensitive, application-specific help.
- use Insert W to hear Windows keyboard commands
Working With the Keyboard Identifier
When the JAWS window is active, Insert-Space Bar will initiate the Keyboard Identifier mode. When this mode is active, entering a JAWS keyboard command will not perform the action, but will state its action.

It is possible to increase or diminish the amount of help provided in the Keyboard Identifier mode through the use of the Insert V (for Verbosity Level) command, the only command which actually works in the Keyboard Identifier mode. If Verbosity Level is toggled from Beginning to Intermediate, more information is spoken as each key command is entered in the identifier mode. This means that the beginning user does not get too much information, and more advanced users can receive in-depth information.

About the JAWS Interface
JAWS uses the numeric keypad as its keyboard base for special reading commands. Two cursors are monitored: a JAWS cursor and PC cursor. It is possible to toggle between the two, and it is also possible to route one cursor to the other cursor. Interactive reading is also possible by using the standard arrow keys. There are two types of commands in JAWS: the majority are reading commands issued from the numeric keypad, but there also are interactive commands issued from the alpha keyboard.

How JAWS Settings are Managed
Basic screen reader settings such as voice pitch and rate, type of keyboard announcement, etc., are accessible through a menu bar in the JAWS Settings Window. Use Insert J to bring up the JAWS application window. There are five menu options:

1. File (use to have JAWS start first, to change from full to laptop keyboard, or to exit the JAWS program)
2. Voices (use to change speech rate; unchanged from Ver. 1)
3. Utilities (to access Macro Editor or Configuration Wizard--for advanced use)
4. Language (use to change languages, if installed, or to change synthesizers, if installed)
5. Help (Contains good information: Help, Command Reference, version changes information, and how to get technical support, and where the user's JFW version number and serial number are listed)

Refreshing the Screen
Sometimes JAWS does not seem to read properly, and when this is suspected, refreshing the screen display with the JAWS command **Insert Escape** will usually restore normal reading function.

**How to Open a Menu**

1. Tap the Alt key and then tap the first letter of the menu option. Once the Alt key has been tapped, it is possible to arrow across through the main menu options.
2. Move down in the menu with the **Down** arrow key.
3. Tap the **Enter** key after hearing the desired topic announced to open its settings box.

**Interactive Hot keys from the Alpha Keyboard**

**Insert B** Read all of **dialog box in Tab** order. This allows the user to understand what is in a dialog box before attempting to Tab through its topic area.

**Insert C** in some applications will read word in context (e.g., spell check).

**Insert F** Identify font name, size and attribute of text at active cursor.

**Insert 5** (from alpha keyboard) identify colors at cursor

**Insert Ctrl F** Begin JAWS search dialogue

**Insert H** Context-sensitive application specific help is verbalized. In a JAWS window, brings up JAWS help. In JAWS window, follow this command with **F1** and then **Q** and the user is at **Quick Start Help**.

**Insert E** In a dialog box or special window, announces what button will be selected if **Enter** is tapped.

**Insert J** Bring JAWS window forward. If JAWS is minimized, this will maximize the window. If JAWS is open but covered, this will bring the window forward.

**Insert F4** Unload JAWS

**Insert F6** Minimize all applications on the desktop

**Insert R** Restrict action of JAWS cursor. If this is turned on, JAWS will read only in the active child window.
**Insert S** Toggle through screen echo settings

**Insert T** Read title bar of window

**Insert V** Toggle through verbosity level. The default setting is novice level, the level which provides the most verbal information.

**Insert W** Speaks general Windows help

**Speech Pad Minus** Turn on JAWS Cursor

**Insert R** The JAWS cursor can read information anywhere in the active window when restriction is toggled off.

**Speech Pad Plus** Turn on PC Cursor. The PC cursor tracks the insertion point or the highlighted selection cursor.

**Insert Up Arrow** Read current line

**Up Arrow** Read prior line

**Down Arrow** Read next line

**Left Arrow** Read prior character

  **JAWS Cursor** Speak prior character.

  **PC Cursor** Select prior icon, select prior menu item, or move insertion point to the prior character.

**Right Arrow** Read Next Character

  **JAWS Cursor** Speak next character.

  **PC Cursor** Select next icon, select next menu item, or move insertion point to the next character.

**Speech Pad 5** Read Current Character

**Insert Left Arrow** Read Prior Word

**Insert Right Arrow** Read Next word
**Insert Speech Pad 5** Read Current Word

**Insert Speech Pad 5** (pressed twice within a half second) Spell Current Word

**Page Up** Move Up One Screen or to Top of Window

  **JAWS Cursor** Move to top of active application or child window depending on the setting for JAWS cursor restriction. (Information about cursor restriction is presented elsewhere in this chapter.)

  **PC Cursor** Move insertion point up one screen.

**Page Down** Move Down One Screen or to Bottom of Window

  **JAWS Cursor** Move to bottom of active application or child window depending on the setting for JAWS cursor restriction. (Information about cursor restriction is presented elsewhere in this chapter.)

  **PC Cursor** Move insertion point down one screen.

**End** Move to the End

  **JAWS Cursor** Move to the end of text on the current line or to the last graphics on current line.

  **PC Cursor** Performs the End function for the application. For example, it could move the insertion point to the end of text on the current line or to the last item in a list box.

**Home** Move to the Beginning

  **JAWS Cursor** Move to the beginning of text on the line or to the first graphics on the line.

  **PC Cursor** Performs the Home function for the application. For example, it could move the insertion point to the beginning of text on the current line or to the first item in a list box.

**Insert Home** Speak From the Left Edge of the Window to the Cursor
**Insert Page Up** Speak From the Cursor to the Right Edge of the Window

**Insert End** Read Top Line of Window

**Insert Page Down** Read Bottom Line of Window

**Insert Delete** Speak the Coordinates of the Active Cursor

**Insert Minus** Route (move) the JAWS Cursor to the Location of the PC Cursor

**Insert Plus** Route (move) the PC Cursor to the Location of the JAWS Cursor. This moves the insertion point or selection cursor to the location of the JAWS cursor and is equivalent to a single click of the left mouse button.

**Insert Escape** Refresh Screen

**Delete** Delete Key

**Alt Delete** Announce Active Cursor Position (in pixels)

**Insert Delete** Announce PC Cursor Position in row and column position

**Alt Insert** Toggle Between Insert and Overwrite Editing Modes

**Alt Control Down Arrow** Read Dialog Prompt

**Insert 3** (from alpha) Pass Next Command Through to Application

**Plus** Invoke PC Cursor

**Minus** Invoke JAWS Cursor

**Minus** (tapped twice) Invoke Invisible Cursor from either PC or JAWS Cursor

**Intermediate Use**

**How to Hear All Dialog Options in Settings Box**
1. Hold down the **Insert** key and tap the **b** key. JAWS will announce the entire contents of the box in the order that the **Tab** key will take. Current settings are not announced.
How to Navigate with Tab Key Through a Dialog Box
1. Tap the Tab key to navigate forward through options.
2. **Shift Tab** will navigate backward through options.
3. JAWS will announce each topic box and its current setting.
4. Use the Arrow keys to move up and down within the topic box to hear other possible settings. Each setting is automatically selected as it is read and automatically de-selected if the arrow is moved off the selection.
5. Once the right setting for the topic is selected, resume with the Tab key to move to the next topic box.
6. If a **scroll bar** is announced in a dialog box, the **Right** and Left arrows will move the **scroll bar** selector point. For example, this is used to set speech rates and volume.
7. A **check box** can be selected or de-selected by tapping the **Spacebar**.

Selecting Text
Key commands for selecting text in Windows applications are listed elsewhere in the training guide. Refer to them for more information. What follows is one way to select two lines of text and read them before deciding to delete, move or copy the text.

1. Type one or two sentences so that text appears on two lines.
2. Make sure the PC cursor is active by tapping the **Insert Del** key to check status.
3. Move the cursor to the beginning of the first line of text.
4. Hold down the **Shift** key and tap the **End** key to select text to end of line. The text will be read.
5. Still holding down the Shift key, tap the **Down** arrow key to select the next line of text. The text will be read.
6. Text can be de-selected by tapping the **Slash(/)** key on the numeric keypad

Copying Selected Text To Another Position In A Document.
1. Enter **Control C** to copy selected text to the clipboard.
2. Move the cursor to another position in the open document.
3. Enter **Control V** to place the copied text.

Deleting Selected Text
Once text has been selected, enter **Ctrl X**.

Moving Selected Text To Another Position In A Document
When text has been cut, move cursor to new position in document and enter **Ctrl V**.
Formatting Text Once It Has Been Selected
The following keyboard shortcuts will format selected text:
- **Ctrl B** Bold
- **Ctrl U** Underline
- **Ctrl Shift Z** Remove formatting and return text to normal

Advanced Use

**How to use the JAWS cursor like a Mouse Pointer**
The JAWS cursor can be used like a mouse pointer with the mouse keys that are described below. To move the Mouse Pointer, use speech pad keys:

- **Slash (/)** Single Left Mouse Click on speech pad
  This selects the item at the JAWS cursor.

- **Slash (/)** twice in a second, Double Left Mouse Click
  This chooses the item at the JAWS cursor.

- **Insert Slash (I)** Drag an Object on the Desktop
  Use the JAWS cursor to point to the object, press Insert and then **Slash (/)** to lock the mouse pointer on the object, then use arrow keys to drag it. Press **Insert Slash (/)** to release the drag command.

- **Asterisk** Right Mouse Click on speech pad

**Restricting Movement of the JAWS Cursor**

- **Insert R** Turn JAWS Cursor Restriction On or Off.

If several application windows are on the desktop, it is possible for them to overlap or totally cover one another. This means that parts of several windows could be visible around the active application window. The PC cursor stays within the active window, which means it will not read information from the surrounding windows. The JAWS cursor also stays within the active window.

The restriction setting does not affect the movement of the PC cursor. When restriction is turned on, the JAWS cursor is restricted to the active section of the screen where it is currently located. If it is in a dialog box when restriction is turned on, it can only read the active dialog option. When using the JAWS cursor restriction, in order to ensure that the cursor is being restricted to the proper section of the desktop, it is best to do the following:
1. Route the JAWS cursor to the location of the PC cursor with **Insert Minus**.
2. Turn on JAWS cursor restriction with **Insert R**.

**How to use the JAWS Configuration Manager**

The Configuration Manager contains a Set Options menu. When you choose a Set Options menu item, a dialog opens. These dialogs enable you to configure your applications to your own specifications.

1. Press **Insert J** to activate the JAWS application.
2. Press **Alt U** to open the Utility menu item.
3. Press **C** to open the Configuration Manager.

**How to use the JAWS Keyboard Manager**

The keyboard manager controls the assignment of keystrokes to JAWS activities. It is important to understand a little about scripts before learning about Keyboard Manager. All JAWS activities assigned to keystrokes are scripts. A script is a small computer program that controls how JAWS reacts and what you hear.

1. Press **Insert J** to activate the JAWS application.
2. Press **Alt U** to open the Utility menu item.
3. Press **K** to open the Keyboard Manager.

**How to use the JAWS Dictionary Manager**

This application allows you to alter the JAWS Dictionary. The JAWS Dictionary is a collection of files that stores all the correctly pronounced words. The Dictionary Manager is the tool that enables you to manage your own JAWS Dictionary files. Press INSERT+D to start the Dictionary Manager and add words to your dictionary.

Use the Dictionary Manager to alter words for specific applications or all your applications. If you want your changes to be saved to all your applications, save the changes to the default file.

1. Press **Insert J** to activate the JAWS application.
2. Press **Alt U** to open the Utility menu item.
3. Press **K** to open the Keyboard Manager.

**How to use the JAWS Frame Manager**

You can use Frame Manager to create and work with frames. Frames are boundaries on a screen for which you define a JAWS action.

- Use a frame to define an area of the window or screen to be spoken automatically.
- Use a frame to define an area of the window or screen to be spoken when a keystroke is pressed.
- Use a frame to define an area of the window or screen for JAWS to ignore.
• Use a frame to define an area of the window or screen for JAWS to treat differently than other areas.
  1. Press Insert J to activate the JAWS application.
  2. Press Alt U to open the Utility menu item.
  3. Press F to open the Frame Manager.

**How to use the JAWS Script Manager**

You create, edit, and compile script files with Script Manager. A script is a small computer program that controls how JAWS reacts and what you hear. For example, when you press INSERT+5, the SayWord script runs. In addition to just saying the current word, it also checks to see if you’ve pressed INSERT+5 twice, in which case it spells the word. Groups of scripts are stored in the script files. There are two basic types of script files: default and application. The default script files contain those scripts and other things that are always available. Application script files contain scripts and other things that are only available when a particular application program is running.

  1. Press Insert J to activate the JAWS application.
  2. Press Alt U to open the Utility menu item.
  3. Press S to open the Script Manager.
JAWS 3.0 with NetScape 3.0

Introduction:
JAWS for Windows is easy to use with NetScape. What follows is a brief list of the most important commands to use in the NetScape environment. The Menu Bar of NetScape can be read as a standard Windows application.

General Suggestions for Reading NetScape Screens:
1. Let JAWS automatically read screen contents before entering any keyboard commands.

2. A fail-safe way of hearing screen again: tap PageDown and then PageUp and JAWS will read the refreshed display automatically.

3. Tap the Tab key to hear what links are on the page.

4. Reread the screen in its entirety again in order to understand the context of the links.

5. Turn on the JAWS cursor by tapping the Minus key on the numeric keypad.

6. Move the cursor to top left corner of document by entering Home and then PageUp from the numeric keypad.

7. Read line by line with the Numpad 2 key.

Basic NetScape Commands:
Maximize the application by entering Alt SpaceBar and then x.

Alt Left Arrow takes the user back through previous screens.
Alt Right Arrow moves the user forward through previous screens.

JAWS Context-Sensitive Help:
Insert Fl provides cursor-specific context-sensitive help.

Insert H provides extensive application-specific help.
Reading Commands:

JAWS automatically begins reading a new screen after it has loaded. Tapping the PageDown key will display more site content if present. JAWS will automatically read these screens.

Control Numpad 2 will cause JAWS to read the entire contents of the screen.

Control stops speech at any time

Tapping Down Arrow when the PC cursor is active generates line-by-line reading.

Accessing Hyperlinks:

Tapping the Tab key takes the user to the first link displayed on the screen. Tab through links until JAWS announces "no more hyperlinks on this page."

Shift Tab takes the user back through the hyperlinks.

Accessing Form Fields:

This capability is one of the most important features incorporated into the JAWS interface for NetScape.

Insert Tab moves the PC cursor to the first edit box of the form field.

Tab moves to the next field.

Shift Tab moves to previous field.

Insert X moves document focus from edit box to screen display, restoring PageUp and PageDown action.

Notes:

Site license costs: for 5 users, $2,400; for 10 users, $4,000; for 15 users, $6,000; for 20 users, $6,500. The SMA or Software Maintenance Agreement is ten percent of the JFW license price and entitles the district to the next two JFW upgrades.

JFW is not available in a network version at this time.
<table>
<thead>
<tr>
<th><strong>Num Lock Key</strong></th>
<th>left mouse button</th>
<th>right mouse button</th>
<th><strong>- JAWS cursor</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>-off</td>
<td></td>
<td></td>
<td>ins + - = routes to PC cursor</td>
</tr>
</tbody>
</table>

### 7 Home

**Reads beginning of text line or first item in list box.**

- **Ins + 7** = reads from beg. of line up to cursor, but not including cursor.

<table>
<thead>
<tr>
<th><strong>8 of</strong></th>
<th><strong>9 PgUp</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Moves insertion point up one screen.</td>
</tr>
<tr>
<td></td>
<td>ins + 8 = reads whole line</td>
</tr>
<tr>
<td></td>
<td>ins + 9 = reads from cursor to end of line.</td>
</tr>
</tbody>
</table>

### 4 4-

**Select previous icon or menu item or move insertion point to previous character.**

- **Ins + 4** = reads previous word

<table>
<thead>
<tr>
<th><strong>5</strong></th>
<th><strong>6 4</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Reads current character.</td>
<td>Select next icon or menu item or move insertion point to next character</td>
</tr>
<tr>
<td>Ins + 5 = reads current word.</td>
<td>Ins + 6 = reads next word</td>
</tr>
<tr>
<td>Ins + 5 twice to spell word.</td>
<td></td>
</tr>
</tbody>
</table>

### 1 END

**Reads end of line or list box.**

- **Ins + 1** = reads top line of the window

<table>
<thead>
<tr>
<th><strong>2 41</strong></th>
<th><strong>3 PgDn</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Reads next line down below.</td>
<td>End of line or list box</td>
</tr>
<tr>
<td>Ins + 2 = reads to end of file or box</td>
<td></td>
</tr>
<tr>
<td>Ins + 3 = reads last line of the window (status line).</td>
<td></td>
</tr>
</tbody>
</table>

### 0 Insert

**With Alt, toggle between Insert and Overwrite mode.**

### . Delete

**With Alt = speaks active cursor**
# JAWS ver. 2.0
## NUMERIC KEYPAD CURSOR FUNCTIONS

<table>
<thead>
<tr>
<th>Num Lock Key - off</th>
<th>/ left mouse button</th>
<th>* mouse button</th>
<th>- JAWS cursor on</th>
</tr>
</thead>
<tbody>
<tr>
<td>Num Lock Key - off</td>
<td>- single click selects</td>
<td>- right button mouse click</td>
<td>- ins + - = routes to PC cursor</td>
</tr>
<tr>
<td></td>
<td>- double click chooses</td>
<td>- ins + * = locks right mouse button.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- shift + / = locks left mouse button</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### 7 Home
Reads beginning of line.
Ins + 7 = reads from beg. of line up to cursor, but not including cursor.

### 8 PgUp
Reads top of application or child window.
Ins + 9 = reads from cursor to end of line.

### 9 PgDn
Reads bottom of application window or child window.
Ins + 3 = reads last line of the window (status line).

### 1 END
Goes to end of line and reads last word or graphic.
Ins + 1 = reads top line of the window.

### 2 40
Reads next line down below.
Ins + 2 = reads from cursor to end of window (say all mode).
Ctrl + 2 = reads active child window.

### 3 PgDn
Reads bottom of application window or child window
Ins + 3 = reads last line of the window (status line).

### Enter

### 0 Insert
With Alt, toggle between Insert and Overwrite mode.

### Delete
Deletes character at cursor
With Alt = speaks active cursor
outSPOKEN (Mac)

Publisher: ALVA Access Group, Inc.  
5801 Christie Avenue #475  
Emeryville, CA 94608  
(510) 883-6280  
aagi.com

RetailCost: $495.00

System Requirements:  
Macintosh

Description:  
At this time, outSPOKEN is the only screen reader for the Macintosh computer. It reads the Macintosh screen display and provides a keyboard alternative to the mouse. Several embossed sheets aid the blind user in understanding the Macintosh screen layout. Instructions also come in Braille.

Recommended Uses:  
Used as a screen reader for persons who are blind, it also is useful for students with learning disabilities who benefit from auditory text editing.

Basic Use:  
1. outSPOKEN is installed in the system folder. Press Command and the Clear key on the numeric keypad to turn outSPOKEN on or off.  
2. Open a file to be read with a word processor.  
3. Using the mouse, place the I-Bar at the beginning of the word or line to be read. Use the following key commands from the numeric keypad.  

Basic Commands:  
To read a line (I-Bar moves to next) Two (2) key  
To read a line (I-Bar does not move) Enter key  
To read word at I-Bar, move right Six (6) key

Other Commands:  
To move I-Bar to top of document screen Seven (7) key  
To read word, move left Four (4) key  
To read one letter, move right Shift Six (6) key  
To read one letter, move left Shift Four (4) key

4. It also is possible to read a word by using the mouse to move the I-bar over the word.
**pwWebSpeak (Win)**

**Publisher:**
Productivity Works  
The Productivity Works, Inc.  
7 Belmont Circle  
Trenton, New Jersey 08618

Tel: (609) 984-8044  
Fax: (609) 984-8048  
info@prodworks.com  
http://www.prodworks.com

**Retail Cost:** $125.00  
(Educational price; site licenses available)

**System Requirements:**
pwWebSpeak will run in Windows 3.x, and Windows 95. It requires 8 MB of RAM and 3 MB of hard disk space. pwWebSpeak requires a speech synthesizer and soon will be able to utilize any sound card as a speech synthesizer.

**Description:**
pwWebSpeak is a text-based browser specially designed for persons with visual disabilities or those who require a non graphical interface. It automatically speaks the contents of a screen and is "smart" about the hierarchy of document structure. Additionally, the program also supports large and user set foreground and background colors.

**Recommended Uses:**
In addition to persons with visual disabilities this browser might be useful for students with learning disabilities who would be distracted by the usual graphical material on a web site, and need to have material read to them. The web site is excellent with much information about the product, how to download a 30 day demonstration copy, and much information on universal design concepts for accessible web design.

**Basic Use:**
1. Load pwWebSpeak from the menu.  
2. Tap Enter until the main page is reached.  
3. Tap the **F2** key to bring up the **Open Location** page.  
4. Enter the following URL: www.htctu.fhda.edu and press Enter.  
5. The High Tech Center Home Page appears. The first paragraph is automatically read.
6. Use the **Down** arrow to read the next paragraph.
7. Experiment with pwWebSpeak by going to Yahoo to browse.
8. Tap the **F2** key again, and enter the following URL: www.yahoo.com. Note that any time a link is encountered, it is announced.

**Commands and Descriptions of Actions**

**F1:** Provides Help information on the commands at any point in pwWebSpeak.

**F2:** Takes you into the Open a Web Page dialog. The user is prompted to enter a web page address. There is no need to enter "H T T P" as this is assumed. Once F2 is pressed, the history of pages visited in a session is directly available by Down or Up arrow. Pressing F2 a second time will open the local page selection dialog. Select a local HTML page to display.

**Shift F2:** Opens the favorites list. Move through the list using the cursor Down and Up keys. A page may be read by simply pressing the **Space Bar** or the **Enter** key.

Any web page may be added to the favorites list by pressing Alt a when the page has been retrieved by pwWebSpeak and is being browsed. When in the favorites list, tapping **Delete** will delete the current entry.

**F3:** Read the current page from current position in the page to the end of the page. During this process it is possible to stop reading by pressing the Q key. To pause reading temporarily, use the F4 key.

**F4:** A toggle key which pauses and restarts when a page is being read or a page element is being read. Not all synthesizers support this function.

**F5:** Jumps and Links list. This allows the user to move up and down through the entire set of links on the page using the Up and Down cursor keys. It is possible to follow any link by simply pressing the Space Bar.

**F6:** Page Elements list. This allows the user to read through the page one logical element at a time by using the cursor Up and Down keys. Down arrow moves forward; Up arrow moves back.

**F7:** Search the Web. This opens a search dialog which provides a front-end to the Alta Vista Internet search engine. The user is prompted to enter a search term. Pressing Enter will then cause the search to be executed. Reviewing the search results is the same as reviewing any web page.
F8: Search for text on the current web page. The user will be prompted to enter a search term. Pressing Enter will carry out the search and a Page Elements list that contains the matching term, if one is found.

F9: This speaks about the current item in a list. Press F9 once in a list to have pwWebSpeak state its reading position, (e.g., "at link 18 of 116") and press it again to read the U R L the list item references, if any. To spell the U R L, press F9 again.

F10: Page Summary. Reads the number of links, images, image maps, and forms that are on the current web page.

F11: Word List. Review each word using the cursor control keys, and read each word separately. Pressing Fl 1 again will spell the last word read. The Down arrow moves word by word through the list, and the Up arrow moves back word by word through the list.

F12: Toggles letter mode on and off when entering text into fields, e.g., the Open Page field, or the Search field.

**Up** or **Down Arrow Keys**: These move you up and down through the lists available to you and through the options available in a Combination Box field or set of Radio button options on a form.

**Space Bar**: This is used to follow a link or open a page from the History or favorites List. It is also used to enter a data entry or selection field on a Form.

Tab: This toggles between three items: the Page Elements list, the Jumps and Links list, and data entry fields, if a Form is present on the page. The new list or field title is announced. When you Tab to a Form field, subsequent Tabs step you through subsequent fields until the end of the Form when you are returned to the Page elements list.

Alt a: Adds the current web page to favorites list.

**Alt b**: Retrieves the immediately prior web page that was browsed.

a: Moves to the next link or HTML anchor on the page.

f: Moves directly to the first form on the page, if one exists. (if there is no form, the result of pressing "f" may be unpredictable.)

h: Moves to the next heading on the page.

p: Moves to the next paragraph on the page.
q: Stop reading or stop a web page transfer that is in progress.

**Ctrl r:** Reload the current page.

**Ctrl s:** Save the current Web page to disk in either HTML or text format (Alt H for HTML or Alt T for text).

**Ctrl F9:** Saves the current page element and adds it to the scrapbook file - scrap.txt

**Alt F4** or **Alt x:** Exit pwWebSpeak and return to Windows 95.

**Alt F:** Faster speech rate each time combination is pressed.

Alt L: Slower speech rate each time combination is pressed.

**Ctrl Fl 1:** Increases print size each time combination is pressed.

**Shift Fl 1:** decreases print size each time combination is pressed.

**Ctrl F12:** Cycles through foreground colors each time combination is pressed.

**Shift F12:** Cycles through background colors each time combination is pressed.

**Shift-Plus** key (on the numeric keypad): Increases Real Audio volume while playing an audio clip downloaded by pwWebSpeak.

**Shift-Minus** key (on the numeric keypad): Decreases Real Audio volume while playing an audio clip downloaded by pwWebSpeak.

**Shift-Star** key (on the numeric keypad): Toggles Real Audio to pause and resume the downloaded audio clip.

**Notes:**
Publisher

Ai Squared
P.O. Box 669
Manchester Center, VT 05255
(802) 362-3612
http://www.aisquared.com

Retail Cost  see notes section

System Requirements

486 or higher processor; Windows 3.1 or 95, 16,256 or High Color display driver; minimum 8 MB RAM (16 MB preferred), Windows sound card or SSIL speech synthesizer (required for levels 2 and 3 only)

Description

ZoomText Xtra comes in two levels now and a third is scheduled for release sometime in 1998. Level 1 is a screen magnifier for the Windows 95 environment. Level 2 offers a fully integrated magnifier and screen reader — designed specifically for the low-vision computer user. Level 3, which is still under development, will add scanning, OCR, form-filling and printing.

Another innovative feature of ZoomText Xtra is its document reading module, called DocReader. Existing in all three product levels, DocReader is a full-screen environment for reading text from any Windows application. DocReader automatically reads through complete documents, including web pages and email.

This version also provides Microsoft's Active Accessibility which should be installed if using Microsoft Office 97 applications.

Recommended Uses

ZoomText is intended for use by persons with low vision. It may also be of value to individuals with learning disabilities.

Basic Use

1. To start ZoomText, choose the ZoomText icon from the Start menu.

2. When ZoomText is active, pressing Alt Delete turns it off. To turn ZoomText back on, press Alt Insert.
3. When ZoomText is active, pressing **Alt Insert** or **Ctrl Shift U** will display the ZoomText User dialog box. Options may be selected from menus or from Tool icons. Selections may be made from the keyboard or with a mouse.

4. Choose **Contents** from the **Help** menu and browse through the excellent descriptions of the programs functions.

**Intermediate Use**

**Enlarging and Changing Text Size**

Text may be enlarged in two ways: from the keyboard, Alt followed by the Plus or Minus key will enlarge or reduce text size.

From the ZoomText menu bar: from the Options menu select Display then click the Magnification tab if it is not already the front tab. From this dialog box it is possible to set horizontal and vertical size, whether the text is proportional (e.g. 3X (Horizontal) by 3X (Vertical) or not, and whether the text is to have smoothed edges (possible with 256 display monitors).

**Choosing Display Style**

From the ZoomText menu bar: From the **Window** menu select the display desired. The default view is **Overlay**. This view places an window in the lower right quarter of the screen. Cursor and Pointer tracking are on. Moving the mouse pans the screen display in this viewing window. The remaining 75% of the screen remains at normal magnification.

There are five main display options: Full Screen, Lens (a movable, sizable rectangle, H-split (horizontal split) and V-Split (vertical split).

**Overlay**

The default setting for ZoomText places the Overlay window in the lower quadrant of the screen. Moving the mouse pans the screen; with tracking on, activities using the cursor and mouse are focused in the window.

**Re-sizing the Overlay View**

It may be useful for students with learning disabilities to re-size the overlay so that only one line of text is magnified. This environment can be used for writing or reading. To do this:
I. Bring up the User dialog box with Alt Insert or with Shift Control U.

2. Select the Re-size icon (the 1st from the left in the lower row of Tool icons.

3. Click the mouse pointer on one of the rectangular "handles" which now appear on the outline of the current overlay window.

4. Click and drag the window borders to the desired positions (left border to the left margin, lower border up a bit, top border down as far as possible, right border a little to the left, if necessary. Click the right mouse button to keep the desired size.

**Full Screen**

For persons comfortable with all of the screen magnified. Moving the mouse (with tracking on) pans the magnified view.

**H-Split**

A magnified view of the screen is displayed in the lower half of the screen. Moving the mouse pans the view in the window. Cursor track places cursor activity in this view.

**Saving Configurations**

Configurations are easily saved or loaded into memory. Because a user can easily save a personalized configuration, it is easy to make ZoomText work in a highly customized setup.

To Save a Setup

1. Make necessary adjustments to ZoomText values.
2. Bring up the ZoomText User window with Alt Insert.
3. Open the File menu and select Save As.
4. Name the file (e.g., suzy). ZoomText automatically adds a .ztw extension.
5. The new configuration file is now listed at the bottom of the File menu, and can be loaded from there.

**Loading Configurations**

There are several different ways to load a configuration: From the File menu, select Load and select the file. Or from the File menu, select the name of the configuration from the bottom of the file menu if it is there. During a work session, once a configuration has been loaded, its name is placed at the bottom of the File menu.
How to Scroll Text

Having text scroll by in a magnified view can be an efficient way for some persons to read text. Entering the hot key command **Ctrl Shift S** brings up the Scroll icon. Click and hold down the mouse button and the screen starts scrolling action in the direction of the mouse drag. Click the right mouse button or press **Escape** to leave the scroll mode.

DocReader

1. Click the **DocReader** button, the open book icon without the pointer, to launch DocReader to read text from the last active application. The DocReader module is a reading environment that reformats, magnifies and speaks text (level 2 & 3 only) from any Windows application.

2. The text of the last opened application is reformatted into the DocReader window and a toolbar appears at the top. This toolbar is used to read through the text in a method similar to using a tape recorder’s buttons. Click on the first button to start reading through the enlarged text. Click it again to stop. For more detailed descriptions of the buttons, see the descriptions from the **Help** menu.

3. With Level 2, speech output is also possible and can be controlled either from the DocReader window or the icons on the application. The icons control the various aspects of the speech function. To learn each icon’s function, from the ZoomText Xtra application, click on the ? icon, then on the icon you wish to learn about. A short description will pop up which explains the function of that icon.

Notes:

**Level 1 Pricing**
- ZX Level 1 (for Windows 95 and 3.1) $395
- ZX Level 1 Plus (includes ZoomText for DOS) $595
- ZX Level 1 Upgrade * (from older ZoomText versions) $95

**Level 2 Pricing**
- ZX Level 2 (for Windows 95 and 3.1) $595
- ZX Level 2 Plus (includes ZoomText for DOS) $795
- ZX Level 2 Upgrade * (from ZX Level 1) $200
  (from older ZoomText versions) $195

**Site License Pricing**
Many site license options are available. For details, see the web site listed above.
Designing Accessible and Attractive Web Pages
Designing Accessible Web Pages

• The Design Process
• Interface Design
• Accessibility Considerations
Understanding the WebServer
Web Browser Relationship
WebS ervers are software which can be used with UNIX, Macintosh or Windows computers for storage and on-demand distribution of text, graphics or other multi-media resources to computers on the Internet.
WebServers communicate with other computers on the Internet through the use of internationally agreed upon protocols and "languages". The communications protocol of the Internet is TCP/IP. The "language" of the web is HTML.
Using TCP/IP, web servers send web browsers content information and display formatting data using HTML.

The "magic" of the web lies in the ability of web browsers to automatically translate this information into formatted pages, pictures and other multi-media.
Web browsers use the power of the client computer to decode and display HTML content in order to …

- view multi-media
- communicate
- examine documents
Organize Your Web Pages
Organizing Your Web Page Links
The Design Process

Before you begin creating a web page, ask yourself the following questions:

Who
Wants What
For Whom
Why
And For How Much
The Design Process

Spend some time thinking about:

• the purpose of the site
• what content it will contain
• availability of the content
• is the content fixed or changing
• who is the intended audience
• what is the bandwidth of their Internet connection
• how the information will be organized
The Design Process

Using whatever tools you like (marker pens and paper, 4 X 5 cards, symbols) create a story board which clarifies and defines the content and organization of your web page.
The Design Process

A simple flowchart is one useful way of diagramming how your pages relate to each other. Using a flowchart lets you resolve any design issues before you create your actual pages.

When creating your flowchart, make sure your pages are arranged in a way that makes it easy for your readers to navigate through the site.
The Design Process

Once you have clarified and defined the content and organization of your web page, begin assembling the text files, photographs, documents and other graphics which will comprise the pages.
Interface Design

The navigational structure you create is as important as the content of the web site itself. Navigational elements should be logical, consistent, simple and intuitive. The best design strategy is to consistently apply a few basic document design principles in every single Web page you create.

• Include a page title and a link to the next, previous and local home page in every WWW page in your system.

• Place navigational icons at the same locations on each page.

• Use the same navigational icons throughout your web site.
Interface Design

Hyperlinks are an integral, and often misused, component of web page design. They may direct the reader to other locations within your site or to other web sites on remote computers. Please consider the following guidelines so as not to confuse users:

• Write about your subject as if there were no links in the text.
• Choose meaningful words or phrases for links.
• Choose an appropriate length for the link text.
• Create context for a link.
• Try to match the link text with the title of the resulting page.
• Don't change text link colors.

Good Link Examples
Graphical images are the glory and the bane of web page designers. Used well, they add information and value to the content of a page. For the most part, images should be in .GIF format with a color depth of 8 bits.

- Use graphics critical to the information content of your page.
- Keep the total size of all images used on a page to less than 30K.
- Include alternate text for each image.
- Use images with transparent backgrounds.
- Use graphical bullets for a purpose.
- Take care with background images.
- Preview your images on several hardware and browser combinations.

**Good Design**
Interface Design

Typography

Good typography depends on the visual contrast between one font and another, and the contrast between text blocks and the surrounding empty space. Nothing attracts the eye and brain of the viewer like strong contrast and distinctive patterns, and you only get those attributes by carefully designing them into your pages.

Typography example
Interface Design

Design for the least common denominator. Assume your user has:

• a 14.4 modem
• a 13 inch low resolution color monitor
• no special viewers
• no plug-ins
Accessibility Considerations

- Graphics/Text Elements
- Sound Elements
- Video Elements
- Page Layout
Enhancing Graphics/Text Access

Design HTML pages to maximize the number of users that can view them. This includes people with text-based browsers, people with slow (modem) connections, people without AN capabilities, people with helper applications missing, and people with disabilities.

Strategy: Provide an alternate text-only page which translates all of the graphic and text information into text only. This can provide a fast access method for all users. Users should be able to switch back and forth between text-only and graphic versions of the page.
Enhancing Graphics/Text Access

Every graphic image or link should have associated text.

If the person viewing the information is using a character-based program (e.g. Lynx), screen reader or has graphics turned off in the browser, awareness of the graphic or link will be lost.

Strategy: Use the ALT attribute to provide short descriptions of the graphic and/or link.
Enhancing Graphics/Text Access

Animated graphics should be avoided or provided with descriptive text.

Animated .gif files can create problems for some screen readers, slow down network traffic and put additional loads on the client computer's processor.

Solution: Use animated .gif files sparingly and always provide a description of the .gif file's actions.
Enhancing Graphics/Text Access

If image maps are used, there should be an alternate method of selecting options.

If the person viewing the information is using a character-based program (e.g. Lynx), a screen reader, or is using a computer which is not capable of displaying graphics, the image will be completely lost; there will be no way to select options.

Strategy: Provide text links below the mapped image which are accessible to screen readers and non-graphical web browsers.
Enhancing Graphics/Text Access

Link descriptors should be concise but not verbose.

Hot links like "this", "here", or "click" do not convey information about the nature of the link.

Strategy: Link text should consist of substantive, descriptive words which can be quickly reviewed by users.

Examples:

   Click here for text only version

or

   Click here for text only version
Enhancing Graphics/Text Access

When using file formats other than HTML (i.e. PDF, MS-Word), provide alternatives methods for viewing the file.

Some file formats such as Portable Document Format (PDF) from Adobe Inc. require special viewers which may be unavailable to the user.

Strategy: Where possible, provide simple text alternatives or links to viewers which provide accessibility to such formats.
Enhancing Graphics/Text Access

Place a dividing character between links which occur consecutively.

Horizontally arranged lists of links can present some screen readers with difficulty in identifying each link.

Strategy: Insert vertical bars between links to prevent a list of links from being read as one link by a screen reader.

Example: Home | Top | Next | Back
Sound Elements

Issues:

* People who are deaf cannot access information which is presented in auditory form only.

* People without audio capabilities in their computer also may not have access.

* People who do not have the proper Audio Player Helper application may not be able to play the audio clip.

* People in noisy environments may not be able to hear information presented audibly.
Sound Elements

Solution:

Maintain a link to a page with a transcript or description of the sound file. Use a phrase such as "hear the speech or read the transcript" with "read the transcript" acting as the link to the transcript.

Audio Examples
Video Elements

The visual component of QuickTime™ and other methods for displaying digital movies in a web environment are not accessible to persons who are blind or have low-vision.
Video Elements

Solutions:

1. Include Caption or Text Tracks with a description of the sounds and words of the movie. Quicktime, for example, allows text tracks which can be viewed at the user's discretion

2. Include an alternate sound track which includes an audio description of the video mixed with the regular audio track. (If your movie format does not support alternate audio tracks then you can provide a second copy of the movie with audio description included)

3. Provide an alternate text file with a description of the movie and a transcript of the audio.
Forms

When HTML pages include forms constructs, it can be difficult for some screen readers and some browsers to handle some forms elements.

Solution:

Provide a form which can be downloaded then mailed or e-mailed, or a phone number to call for the requested information.
Tables

Tables cause problems for screen reading software since screen readers tend to read across the screen in a way that runs all of the text on a line together. If an entry in a cell occupies more than one line the first line of each cell would be read, then the second etc.

Solution:
No good solutions exist at this time. If possible, avoid using TABLE structures. Alternately, you might present the data on an alternate text-only page without tables.
Page Layout

Colors and Fonts

Text colors, background patterns/colors and fonts should be selected for contrast and readability.

1. Background patterns and color should contrast well with the lettering to maintain readability (background refers to both backgrounds of pages and backgrounds of images).

2. Select colors that will make your pages easy to read by people with color blindness. One good test is to see if your pages are readable in black and white.